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Synchronizing account data from SAP to Salesforce.com
using IBM App Connect

This tutorial illustrates how you can use IBM® App Connect Professional on Cloud to synchronize
account records in SAP in a private network with Salesforce.com’s cloud offerings.

© Copyright IBM Corp. 2017 1
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Introduction

This tutorial provides an example of cloud data synchronization (cloud data sync), using IBM App Connect
Professional on Cloud to synchronize customer data between SAP in a private network and
Salesforce.com’s cloud offerings.

A company has an SAP enterprise resource planning (ERP) system in its own private network and uses
Salesforce.com as their customer relationship management (CRM) system in the cloud. The CRM system
is used by the call center and the sales teams to communicate with their customers. To work with the
CRM system, account data is needed. This account data is available in SAP but has to be synchronized
with data in Salesforce.com.

The company made the following decisions about data management:
v New customer accounts are created in SAP.
v Users of Salesforce.com are allowed to modify customer data such as addresses, but that needs to be

reflected in the master SAP records.

IBM App Connect Professional is used to keep the data of the two systems synchronized. The App
Connect Secure Connector provides secure communication through the company's firewall.

Disclaimer

The intent of this tutorial is to demonstrate the use of IBM App Connect Professional to integrate
third-party applications and does not claim any endorsement or affiliation with the listed products. All
product and company names are trademarks or registered trademarks of their respective holders, and
IBM disclaims any ownership in such third-party marks. Use of such third-party marks does not imply
any affiliation with or endorsement by or for IBM or IBM WebSphere Cast Iron Cloud Integration. The
use of any third-party trademarks, logos, or brand names is for informational and instructional purposes
only, and does not imply that such trademark owner has authorized IBM to promote its products or
services.

Overview of use cases

This tutorial implements the first of two use cases that provide bi-directional data sync between SAP and
Salesforce.com:

Figure 1. IBM App Connect Professional performing cloud data sync between SAP and Salesforce.com.
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v Synchronizing new and updated customer data from SAP into Salesforce.com
For this use case you create an integration project by using IBM App Connect Professional’s
configuration-not-coding approach and exploiting a pre-built Template Integration Project (TIP) that
includes preferred practices.
When the integration is triggered by an HTTP request, customer records are read from SAP and
corresponding accounts upserted in Salesforce.com: if an account does not exist in Salesforce.com, the
account is created; otherwise, if a SAP customer record has changed the account is updated.

v Synchronizing updated account data from Salesforce.com into SAP
For this use case, the subject of a separate tutorial, you create an integration project without using a
TIP, but exploit artifacts from the first use case. This tutorial explores the details of an integration
project that implements cloud data sync from Salesforce.com to SAP. You run the integration to reflect
into SAP changes made to customer accounts in Salesforce.com.

Learning objectives
v See how easy it is to sync data between SAP in a private network and Salesforce.com cloud offerings
v Understand how to create an integration project from a template
v Get a meaningful experience of using the web management console and Studio of IBM App Connect

Professional
v See how easy it is to configure and use the App Connect Secure Connector for secure connection

between the public cloud and a private network.

Time required

This tutorial should take approximately 60 minutes to finish. If you explore other concepts related to this
tutorial, it could take longer to complete.

Skill level

Any skill level for IBM App Connect Professional.

A good SAP skill level, to be able to configure SAP and create new test accounts.

Audience

Developers of integration solutions interested in using IBM App Connect Professional for cloud data
sync.

Online resources
v This tutorial web page in the IBM Integration community (Developer Center)
v PDF of this tutorial

Tip: If you have difficulty with the resource links, open the following address in your web browser to
browse and select files: ftp://public.dhe.ibm.com/software/integration/hybrid_integration/appconnect/

Requirements

Before starting this tutorial, ensure that you have the following requirements ready:
v IBM App Connect Professional.

This tutorial was prepared using the free full-featured IBM App Connect Professional trial. Try IBM
App Connect Professional for free.

v A Salesforce.com account that is to be used to read account data from Salesforce.com and to create and
update account data in Salesforce.com.
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This tutorial was prepared using a free Salesforce Developer account.
Note the username, password, and security token of the Salesforce.com account, for use when
configuring connection to Salesforce.com.

Tip: The security token is needed because connectivity is provided through the Salesforce.com API. For
information about finding your Salesforce.com security token, see Reset Your Security Token in the
Salesforce help.
In Salesforce.com, you must define the following custom fields for the Account object:
– An external ID field of type text and an external ID named ExtAccountID or similar. The external ID

is to be used to contain the SAP customer number in a format of SAP_xxxxxx.
– An external field of type text that is named SalesOrganization or something similar.

v SAP system and user.
You must have access to an SAP system with valid customers.
You must have an SAP user account that can read customer data from SAP and be allowed to update
customer data in SAP.

v Prepare support for SAP connectivity.
To be able to connect to SAP from App Connect Professional, you need to install a few SAP libraries
into App Connect and install the App Connect Secure Connector on a computer on your network with
access to the SAP system. To prepare support for SAP connectivity, complete the steps in Appendix A,
“Preparing SAP connectivity for App Connect Professional,” on page 35

v Use a web browser such as Internet Explorer, Mozilla Firefox, Apple Safari, or Pale Moon to log in to
App Connect Professional.
In this tutorial, you use the Studio (a Java™ Web Start Application) of App Connect Professional to edit
an integration project. To run a Web Start application (like Studio) from your web browser, Oracle
recommends using a web browser such as Internet Explorer, Mozilla Firefox, Apple Safari, or Pale
Moon. Alternatively, you can download the Studio JNLP file to your computer and then run that file
locally with the Java Web Start application (javaws) of the latest java version installed on your
computer. For more information, see the blog post, Java Web Start in or out of the browser.

Tip: To run Studio as a Java Web Start application from your web browser, ensure that you have
selected the Java option "Enable Java content in the browser" and added the following site to the
exceptions list: https://castiron.ibmcloud.com/

Expected results

Several customer records are read from SAP and stored in account records in Salesforce.com.

Conventions and capabilities used in this tutorial

Terminology:

Endpoint
An application that App Connect connects to.

Orchestration
A flow that represents an integration use case in App Connect Professional.

Studio
The development environment in App Connect Professional, downloaded on request as a
Java web start application.

Web management console
The web-browser application used to manage App Connect Professional, and for some
development of integration projects
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App Connect Secure Connector
The App Component that enables secure connectivity between applications running
behind a firewall and applications running in the public cloud.

Template used: T0037 - SAP Customers To Salesforce Accounts
This TIP searches for customer records in SAP and upserts the data into account records in
salesforce.com. (If an account record does not exist in salesforce.com, the account is created. If the
account exists, it is updated.)

Activities used:

v HTTP Receive Request
v SAP - Invoke BAPI (to call a Business Object Method (BAPI) that is enabled at the specified

SAP endpoint)
v Try...Catch (to report any failure to insert a record into Salesforce.com)
v If Then...Else (to add business rules or business logic)
v Salesforce – Create Objects
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Summary

You create and run an integration project in IBM App Connect Professional that synchronizes customer
data from a SAP ERP system to create Account records in Salesforce.com.
1. Use the web management console to create an integration project from a template.
2. Open the project in the Studio to make a few changes to the configuration of your project.
3. Test the project in the Studio to verify that customer data in SAP can be synchronized with

Salesforce.com.
4. Deploy the project to run in App Connect Professional on cloud.
5. Invoke the project running in the Production environment of App Connect Professional on cloud

© Copyright IBM Corp. 2017 7



8 IBM App Connect Professional: Tutorial: Data sync between SAP and Salesforce.com



Creating the project in the web management console

You first create an integration project from a template in the web management console and use a wizard
to configure most of properties required for the project.

Procedure
__ 1. Log in to IBM App Connect Professional.

This displays the web management console, showing the tabs for Create, Modify, and Run; the
three main steps to get your integration solution running.

__ 2. In the web management console, click the Create tab. You use the Create tab to select a template
to create an integration project or create a project from scratch.
In this tutorial, we want to find and select the template to synchronize SAP to Salesforce.com. For
example:
a. Expand the Source Endpoint drop-down menu
b. Type s and then scroll down to and select SAP.
c. Expand the Target Endpoint drop-down menu
d. Type s and then scroll down to and select salesforce.com.
e. Select Search (next to the Target Endpoint drop-down menu).

This displays a table of templates for integration from SAP to Salesforce.com.
f. Scroll down and then select the template T0037 - SAP Customers To Salesforce Accounts

The template row indicates that the TIP is certified by IBM as depicting a common use case
and using preferred practices.

Figure 2. The web management console after logging in to IBM App Connect Professional on Cloud
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g. Select Create a project based on this template.
After a short while, the TIP configuration wizard is displayed.

__ 3. On the wizard Introduction page, click Next.

Figure 3. Web management console, selecting the T0037 template to create a new project

Figure 4. The TIP configuration wizard, as first opened
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__ 4. On the Prerequisites page, ensure that you have completed the prerequisites mentioned.
For more information about the prerequisites, see “Requirements” on page 4.
To continue, click Next.

__ 5. On the Enter Credentials page, enter the credentials for your SAP and Salesforce accounts.
a. Enter your user name and password for Salesforce.com.

The password value for Salesforce.com is the account password concatenated with the security
token. For example, for password mysfpwd and security token 1AB2CdEfg3HijkLM4NOpqrsTu, the
password to enter would be: mysfpwd1AB2CdEfg3HijkLM4NOpqrsTu.

b. Enter the details needed to connect to your SAP system.
In this example, we obtained the SAP hostname (IP address), system number, client number,
user name, and password from our SAP administrator.

c. Adjust the other settings: the SAP Sales Organization, the SAP Country, and SAP Search flag
to fit your environment. These are the default values used by App Connect to search for
customer records in SAP. (You can change the search values later.)

__ 6. On the Verify Salesforce.com connectivity page, click Test Connection to verify that IBM App
Connect Professional can connect to your Salesforce.com account.
This page provides options for your to customize the Salesforce.com connectivity, if you need to.
In this tutorial, we log in normally with the Salesforce.com account name and password
(concatenated with the security token) as specified earlier.

Click Next to continue.
__ 7. On the Verify SAP connectivity page, verify that IBM App Connect Professional can connect to

your SAP system.
This page provides options for your to customize the SAP connectivity, if you need to. In this
tutorial, we log in with the SAP user name and password specified earlier for authentication.

Figure 5. The TIP configuration wizard, Verify Salesforce.com connectivity page
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Before you test a connection to SAP in a private network, ensure that the App Connect Secure
Connector is running, and that your computer can connect to the SAP endpoint (for example, can
ping the SAP hostname or IP address).
To verify that IBM App Connect Professional can connect to your SAP system, click Test
Connection.

Click Next to continue.

Tip: If you have a problem connecting to SAP, here are some things to check:
a. The App Connect Secure Connector is running, as indicated by the Status RUNNING on the

Production environment tab of the web management console; System > Secure Connectors.
(See the figure Figure 6.)

b. The App Connect Secure Connector has been installed on a computer that can connect to the
SAP endpoint, and has been configured properly. For more information about installing and
configuring the Secure Connector, see “Installing the App Connect Secure Connector” on page
37.

c. You have installed the SAP libraries into App Connect, as described in “Installing SAP library
files for use in App Connect Professional” on page 35

d. Check if you need to update any of the SAP library files, as described in “Checking and
updating installed SAP library files” on page 47.

__ 8. On the Change search criteria for SAP Customer list page, leave the default settings.
On this page, you can change how to get Customer records from SAP. In the To Activity cell there
are three parameters that have the letter D to the right of the name. This letter indicates that a
default value is defined for these values, to be matched when searching for Customer records in
SAP. The elements hold country and sales organization information and a search flag. The default
values refer to the configuration properties that you specified earlier. If you want to change the
default value of a parameter, you can right-click the parameter name and then select from the
context menu.

Figure 6. The TIP configuration wizard, Verify SAP connectivity page
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Click Next to continue.
__ 9. On the Get salesforce.com custom fields page, select the primary ID and custom fields for sync

with Salesforce.
On this page, you can select the primary ID that is used to identify whether a create or update
occurs in Salesforce.com. In addition, you can select the fields that you want to send to
Salesforce.com.

Tip: Custom fields in Salesforce.com end with __c.

Note in Figure 7 that the fields displayed are not identical to the fields of your Salesforce.com
account. Specifically, the SalesOrganization field is missing, and is to be added.
a. To retrieve the list of fields that are available for your Salesforce.com environment, click the

blue circle.
The wizard connects to Salesforce.com and after a short while retrieves the current list of
standard and customer fields, also called meta data, for your Account object.

b. Verify that the list is updated with the ExAccountID__c and SalesOrganization__c fields and
that they are selected, as shown in the following figure:

c. Select ExtAccountID_c in the list of custom fields, and verify that ExtAccountID__c is selected
in the External ID field (shown at the top of the window), as shown in the figure Figure 7.

d. Clear fields that you do not need, for example the fields for shipment details, such as
ShippingCity.

Click Next to continue.

Figure 7. The TIP configuration wizard, Get salesforce.com custom fields page

Figure 8. The TIP configuration wizard, new fields for account object
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__ 10. On the Change Account Mapping page, add a mapping for SalesOrganisation__c and update the
mapping for ExtAccountID.

As shown in the figure Figure 9, the field for the sales organization on the right side is not
mapped. To store the sales organization into Salesforce.com, you must map information into the
field. Also, we want to change the default mapping for the ExtAccountID__c field.
a. Map the sales organization field.

1) Right-click the SalesOrganisation__c field
2) Select Define Default Value

3) Click the symbol on the right of the entry field
4) Select the configuration property SAPSalesOrg
5) Click OK.

Figure 9. The TIP configuration wizard, Change Mapping page
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The SalesOrganisation__c is shown with a default mapping (D symbol)
b. Update the ExtAccountID mapping.

Follow the link from the SAP field CUSTOMER field on the left to the Salesforce.com
ExtAccountID__c field on the right. This is a direct mapping, meaning that the content is
copied from the source to the target.
However, for this use case, we want Salesforce.com to use the SAP customer number with the
following format:
SAP_SAPcustomernumber

Therefore, you must modify the mapping, and enhance it with a concatenate function.
1) Click the function symbol (f) to the left of the Back button, located at the bottom of the

panel, as indicated in the figure Figure 9 on page 14.
2) Drag the Concatenate function and drop it onto the line between CUSTOMER and

ExtAccountID__c.
3) Double-click the Concatenate (&) symbol, to open the concatenate function.
4) Enter SAP_ for the second input string, and then click Up to concatenate 'SAP_' before the

customer value.

Figure 10. The TIP configuration wizard, Mapping the SAP sales organization
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5) Click OK, and then right-click the Concatenate function symbol (&), and select Apply
Function Graph.

The ExtAccountID__c mapping is now shown as in the figure . The mapping is now finished
from SAP to Salesforce.com.

Click Next to continue.
__ 11. On the Map Account fields page, leave the default mappings.

On the Map Account fields page, you may update the map used to sync data from SAP to the
Salesforce Accounts.
Click Next.

Figure 11. The TIP configuration wizard, Updating the ExtAccountID__c mapping

Figure 12. The TIP configuration wizard, the completed ExtAccountID__c mapping
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__ 12. On the Verify Integration page, click Save.
The project is added to the Modify tab, which is opened automatically.

Hint: In this example, the project was saved with a new name, SAPCustomerToSFDCAccounts.
(If you are not offered the chance to save the project with a new name, you can save the project
with a new name when editing in the Studio.)

Tip: Before we can verify this integration project, or publish it into production to run in App
Connect Professional on Cloud, we need to edit the project in the Studio to change a few
configuration options.

Figure 13. The TIP configuration wizard , new project opened in the Modify tab
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Editing the project in the Studio

To enable a project to be run in App Connect Professional on cloud, you use the Studio to set options to
run in the cloud and note the URL for the project that you use to interact with it.

About this task

The web management console is convenient for creating your first integration project, or the initial state
of other projects, but there is more that you can do in the Studio to create and customize your projects.

For example, before you can run your new project in App Connect Professional on cloud, you use the
Studio to select the option to run in the cloud and note the URL for the project that you use for data sync
between SAP and Salesforce.com. You can also customize the URL and other aspects of the project.

Procedure
__ 1. In the web management console, in the Actions column for the project, select Edit Project in

Designer.
This downloads and runs the App Connect Studio launcher application (JNLP file) to start the
Studio as a Java Web Start application. There is some delay as the launcher application and Studio
are loaded and initialized.
During the download, if you see a Java security request to run the App Connect Studio launcher
application, select the option to run the application.

Tip: After the first time that you launch the Studio from the web console, you can launch the
Studio by opening the downloaded JNLP file, or again from a project's Edit in Designer action of
the web management console.

__ 2. When the Studio has downloaded, it opens the wizard to configure the project.
In this tutorial, the wizard is only used to import the project into Studio, where the project is to be
configured.
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Select Next to continue.
__ 3. On each page, select Next, until you see the Publish Project page.
__ 4. On the Publish Project page, select Finish.

This displays the Finished page, where you can publish a review of this TIP. You can do that at a
later time.
Select Close.
The project is opened in the Studio to show its orchestration (flow).

__ 5. Set options to run the project in the cloud, and determine the URL to be used.
a. Edit the HTTP Receive Request node; for example, select the node on the palette.
b. On the Configure view, note the value of the parameter URL (Path After Hostname); by default,

/SyncSAPSFDC.
This is the unique value used to invoke this project when published. (Optionally, change the
value, but if you do remember the new value to use later.)

c. On the Pick Endpoint view, click Edit.
d. In the Edit Endpoint window, in the Location section, select the check box Configure for App

Connect on cloud and note the hostname and port to be used later: https://
provide.castiron.ibmcloud.com:443

e. Edit the SAP endpoint node; for example, select the node on the palette.
f. Select the check box Endpoint Runs Behind Firewall and then enter the Secure connector

Name SC4SAPConnectivity
For projects running in the cloud (Production environment), the name of the secure connector
needs to be provided in every endpoint which is behind the firewall. The one secure connector
can be used by more than one endpoint/orchestration.

g. Click OK.

Figure 14. Studio, project configuration wizard
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__ 6. Validate the project by selecting Orchestration > Validate, or by selecting the Toolbar 'tick' icon:

You should see the success message The Studio Project is Valid. Close the message window.
__ 7. Save your project to the cloud.

a. Ensure that you are still logged in to App Connect Professional on cloud. If you see a Login
link at the bottom of the Studio, select the link to log in.

b. Select File > Save Project (To Cloud) or select the Toolbar 'Save' icon: 

Figure 15. Logging in to the Studio after a period of inactivity
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Verifying the project in the Studio

You can verify an integration project by running the orchestration in the Studio. This makes requests
directly to SAP, to upsert customer data to Salesforce.com.

Before you begin

Before you verify the orchestration, check with your SAP administrator that the SAP query will not
return hundreds of records, which can cause problems in Salesforce.com.

In the project, the SAP endpoint has been configured as running behind a firewall, with connection
through the App Connect secure connector. Such connection cannot be verified in the Studio, so you have
to select to verify the project using direct connection to SAP (otherwise known as "non-remoteable"
verification). You can use either of the following techniques:
1. When you start the orchestration (below), you should see the message:

The orchestration contains one or more activities that are marked as running behind the firewall.
This kind of configuration cannot be verified within Studio, but only in the App Connect on cloud.
Do you wish to verify them as non-remoteable activities?

Yes | No

To verify the project within the Studio, select Yes.
2. Before starting the orchestration, edit the SAP endpoint node, and temporarily disable use of the

Secure Connector:
a. Clear the check box Endpoint Runs Behind Firewall (temporarily to verify the project in the

Studio).
b. Click Test Connection, to test that you can connect to the SAP system. You should see a message

to indicate that you've successfully connected.
If the Studio is unable to connect to SAP, check and, where needed, update the installed SAP
library files.

Procedure
__ 1. Click the Verify tab

This shows the controls for running the orchestration, and the records of each previous instance
that the orchestration was run.

__ 2. Start the orchestration
For example, click the Start Orchestration icon:

The control changes to show Stop Orchestration.
__ 3. Start the HTTP Post Utility

The orchestration is triggered by an HTTP request. So, start the HTTP post utility using Tools >
HTTP Post Utility.

__ 4. Submit an HTTP GET request.
Use the following URL to send the request: http://hostname/SyncSAPSFDC, where hostname is the
host name of the computer where you are running Studio.
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Studio shows that the orchestration is triggered and completes quickly, unless you have a lot of
customer accounts that are processed or a connection problem. In the Verify tab, expand the tree
for this instance of the orchestration, and verify the accounts that were processed.

Figure 16. Using the HTTP Post Utility to trigger the SyncSAPSFDC orchestration in the Studio.

Figure 17. Instance record of the SyncSAPSFDC orchestration showing account created result.
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__ 5. Log into Salesforce.com, and verify that the accounts were created.

If you edit an account, you can see the data added from the search parameters (like Sales
organization), the mapping (external account ID SAP_nnnn) and from SAP.

__ 6. You can now close the Studio.

Remember: If you choose to save the project to the cloud, first ensure that you have selected the
check box Endpoint Runs Behind Firewall on the SAP endpoint node.

Figure 18. Salesforce.com, accounts created/upserted by the SyncSAPSFDC orchestration for data from SAP.

Figure 19. Salesforce.com, accounts created/upserted by the SyncSAPSFDC orchestration for data from SAP.
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Deploy the project to run in App Connect Professional on
cloud.

To be able to run the project in App Connect Professional on cloud, you publish the project to the
Production environment in the web management console and then start the project running.

Procedure
__ 1. In the web management console, select the Modify tab.
__ 2. Publish the project to the Production environment.

In the Actions column for the project, select Publish Project.
__ 3. Select the Production tab.

You can see the SAPCustomerToSFDCAccounts (stopped) project in the list.
__ 4. Ensure that the App Connect Secure Connector is running before starting the project.
__ 5. Start the project running.

In the Actions column for the project, select Run Configuration.
You can see that the project is moved into the running state, ready to be invoked to upsert
customer data from SAP to Salesforce.com.
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Invoke the project running in the Production environment of
App Connect Professional on cloud

To invoke the project running in the Production environment, use your preferred technique to submit
HTTP requests; for example, the Linux command line and curl, the HttpRequester add-on for Firefox, or
another utility like Postman.

About this task

This example uses the Postman utility.

For information about the HttpRequester add-on for Firefox, see HttpRequester.

Procedure
__ 1. Optional: In your web browser, log in to Salesforce, and then refresh the Accounts view to see the

list of accounts before the project has been invoked. Ideally, delete any accounts created when
testing the project in the Studio.

__ 2. In Postman, complete the following steps to invoke the project:
a. Select the GET method.
b. Enter the URL string containing the App Connect Professional hostname and port that you

noted when configuring the project in the Studio. Append the environment value, Deployment,
and the URL parameter (for example, /SyncSAPSFDC) that you configured earlier to be used to
invoke the project.
The URL, should be like the following:
https://provide.castiron.ibmcloud.com:443/env/Production/SyncSAPSFDC

c. Select the Authorization tab, choose Basic Auth, and then set Username and Password to the
values for your IBM ID.

d. To invoke the integration project, click Send.
If you have done everything right, you get a 200 success message in Postman: Message
accepted by the Cast Iron Cloud
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__ 3. In Salesforce, refresh the Accounts view.
You should now see the Account records created in Salesforce, for customer data created from SAP
by App Connect Professional.

__ 4. Optional: To browse any of the Accounts, select the Account Name link.

Figure 20. Postman utility, success message after invoking the project to sync data from SAP to Salesforce.com

Figure 21. Salesforce.com, accounts created/upserted by the SyncSAPSFDC orchestration for data from SAP.
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__ 5. In SAP, change one or more of the customer records. For example:

__ 6. In Postman, invoke the integration project again. Click Send.
__ 7. In Salesforce, refresh the Account detail view.

You should now see the changes to the Account record in Salesforce, for customer data upserted
from SAP by App Connect Professional.

Figure 22. Salesforce, details view of an account created for data from SAP.

Figure 23. SAP, changed customer record

Figure 24. Salesforce, details view of an account upserted for data from SAP.
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Conclusion

In a matter of minutes, you created and ran an integration project in IBM App Connect Professional to
sync customer data from a SAP system on a private network, to create and update Account records in
Salesforce.com.
1. Used the web management console to create an integration project from a template.
2. Edited the project in the Studio to make a few changes to the configuration of your project.
3. Verified the project by running it in the Studio.

a. Used the HTTP Post Utility in the Studio to trigger the orchestration and get some customer data
from SAP and pass the data into account records in Salesforce.com.

b. Used a web browser to log in to your Salesforce.com account and checked that the Accounts were
created from the SAP data.

4. Deployed the project to run in App Connect Professional on cloud.
5. Invoked the project running in the Production environment of App Connect Professional on cloud

a. Used the Postman utility to invoke the project to create account records in Salesforce.com for
customer data from SAP.

b. Used a web browser to log in to your Salesforce.com account and checked that the Accounts were
created from the SAP data.

c. In SAP, changed one or more customer records.
d. Used the Postman utility to invoke the project again to update the account records in

Salesforce.com for customer data changed in SAP.

This has shown use of App Connect to sync customer data from SAP to create accounts in Salesforce.com,
and then to update those accounts for changes made to customer data in SAP.

This completes the tutorial.
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Appendix A. Preparing SAP connectivity for App Connect
Professional

To be able to connect to SAP from App Connect Professional, you need to install a few SAP libraries into
App Connect and install the App Connect Secure Connector on a computer on your network with access
to the SAP system.

Procedure
1. Install SAP library files for use in App Connect Professional
2. Install the App Connect Secure Connector

What to do next

When later trying to connect to SAP, if you get an Unable to Connect error you can usually restore
connectivity to SAP by checking and updating the installed SAP library files.

Installing SAP library files for use in App Connect Professional
To be able to connect to SAP, App Connect Professional needs a few SAP JCO libraries installed.

About this task
v To be able to run integration projects in an App Connect environment in the cloud, the SAP JCO

libraries need to be installed into the environment through the web management console.

Tip: The same SAP libraries need to be installed into the App Connect Secure Connector, when you
install the Secure Connector.
To get the SAP JCO libraries, contact your SAP system administrator who can download the libraries
files from the SAP support site. Have these files available on the computer where you are developing
the project. The list of SAP libraries are given below:
– sapjco3.jar
– sapjco3.dll
– sapidoc3.jar

v Occasionally, the com.approuter.module.jcaconnectors.sap.tp-1.0.0.jar in the Studio needs updating to be
able to connect to SAP from the Studio when developing and testing integration projects.

Tip: This JAR file only needs updating sometimes after downloading the Studio, and if needed, you
can download this JAR file from the web management console.

The following steps use the files on a Windows computer, with the web management console, to install
the SAP JCO libraries into the App Connect runtime environment (Production) in the cloud.

Procedure
1. Log in to IBM App Connect Professional

This displays the web management console, showing the tabs for Create, Modify, and Run; the three
main steps to get your integration solution running.
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2. In the web management console, select the Production environment, into which the SAP libraries are
to be installed.
a. Click Settings

b. In the Settings window, click Edit for Libraries Environment
c. Select the libraries environment Production, and then select Save

This step specifies that the SAP libraries are to be added to, and used from, the Production
environment.

3. Add the SAP library files into the Production environment
a. Select the Production environment tab
b. Select System > Connector Libraries

c. In the Update Connector Libraries window, select SAP as shown below.
d. Click on the "+" symbol, and then browse to and add the three files one by one.
e. Select Update, to add the files to the environment.

After a short while, the library files are added to the environment.
In the System > Connector Libraries view of the Production tab, you can see the files are listed under
the Installed Files section for SAP.

Figure 25. The web management console after logging in to IBM App Connect Professional on Cloud

Figure 26. SAP libraries installed into App Connect Professional
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Results

The SAP JCO library files are installed in the Production environment, as shown in the web management
console.

(Any need to install other SAP files into the Studio is occasional, and only if indicated when trying to
connect to SAP.)

What to do next

If you haven't already done so, install the App Connect Secure Connector (including the same SAP JCO
library files), as described in “Installing the App Connect Secure Connector.”

Installing the App Connect Secure Connector
The App Connect Secure Connector provides secure bidirectional data transfer between App Connect
Professional on Cloud and SAP (or other endpoints) that are located behind a firewall.

About this task
1. Create a secure connector in the Production environment of the web management console.
2. Download the secure connector configuration file and secure connector installer.
3. Install the App Connect Secure Connector on a computer behind your firewall.
4. Download and install vendor-supplied libraries to use with the App Connect Secure Connector.

The following steps are based on a scenario where IBM App Connect Professional is to connect to a SAP
system behind a firewall, as part of a data sync solution between SAP and Salesforce.com.

Procedure
1. Log in to IBM App Connect Professional

This displays the web management console, showing the tabs for Create, Modify, and Run; the three
main steps to get your integration solution running.

Figure 27. Example scenario: Data sync between SAP and Salesforce, through App Connect Professional and secure
connector
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2. In the web management console, select the Production environment tab, which is to be used to
connect to SAP.

3. Create a Secure Connector
a. Display the Secure Connectors pane. Select System > Secure Connectors

b. Click New Secure Connector

c. Provide a name for the new Secure Connector. For example: SC4SAPConnectivity

Remember: Remember the name for the new Secure Connector. You specify this name later when
configuring the SAP endpoint in the Studio.

d. Optional: Provide a description for the Secure Connector. For example: Secure Connector for SAP
connectivity

e. Click Save

The secure connector is displayed in the Secure Connector page.

Figure 28. The web management console after logging in to IBM App Connect Professional on Cloud
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4. Download the secure connector configuration file and secure connector installer.

Important: Although you can place the installer file into a temporary directory, you must save the
configuration file into a directory that is persistent. During the installation, the configuration file is not
copied. Instead, a reference to the file is created and used whenever the Secure Connector starts, so
the file must be in a known location for as long as the Secure Connector might be used.
a. From the Secure Connectors page, click the Secure Connector name. The Edit Secure Connector

dialog box shows the authentication key for the Secure Connector.

Figure 29. Creating a new secure connector in the web management console

Appendix A. Preparing SAP connectivity for App Connect Professional 39



b. Click Download Secure Connector Configuration, and then click Download Now.
c. Save the file to your computer.

The name of the file includes the environment name (Production) and the connector name
(SC4SAPConnectivity, that you provided); for example: SecureConnector-
Production_SC4SAPConnectivity-Configuration

d. In the Edit Secure Connector dialog box, click Download Installer, and then the link for the
operating system that you want the Secure Connector to run on.
In this example, the Windows 32-bit installer was downloaded, and has the file name
windows-secure-connector-installer.exe.

5. Install the Secure Connector on Windows
Ensure that the configuration and installer files are available to the computer where you want to
install and run the Secure Connector.
Complete the following steps on the computer where you want to install and run the Secure
Connector.
a. Start the installer. Click the installer file executable (windows-secure-connector-installer.exe).
b. If a Security Warning panel is display, click the option to allow the installer to continue.
c. In the Welcome panel, click Next.

Figure 30. Edit Secure Connector, showing its authentication key
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d. Read and accept the Licensing Agreement, and then click Next.
e. Specify the installation path Either accept the default path or specify your own path. In this

example, use the following path: C:\IBM\Secure_Connector_1.7.5.2.0 If it does not already exist,
you are informed that the target directory will be created. Click OK, and then click Next to
continue.

f. Choose the shortcuts. Accept the default settings, and then click Next.
The installer starts the installation, and finishes in a few minutes. When finished, the progress bar
looks as shown in the following figure.
Click Next to continue.

Figure 31. Secure Connector installer, page 1
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g. Specify the location of the downloaded configuration file Click Browse to find and select the
configuration file SecureConnector-Production_SC4SAPConnectivity-Configuration.

Tip: You might need to expand the installer window to see the Browse button.

Figure 32. Secure Connector installer, installation finished
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Click Next to continue. The installation wizard reads the configuration file and displays the user
data.

h. In the User Data window, ensure the ports used are OK, then click Next to continue.
Ensure that the listener port, which defaults to 2500, is not already in use in your system. If
required, change the port to a port that is not in use.

Tip: Note that the Name parameter matches the name that you specified when you created the
Secure Connector in the web management console.
If you need to do so, you can click Previous to select a different configuration file.

Figure 33. Secure Connector installer, configuration file
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i. If your computer cannot connect directly to the Internet, but is using a proxy, you can specify the
proxy details, including password.
This example does not need to specify a proxy.
Click Next to continue.

j. If you want to run the Secure Connector as a Windows service, specify the details.
This example starts the Secure Connector manually, so do not enable this option.
Click Next to continue.

k. On the Install Vendor Supplied Libraries page, install any library files needed to connect to the
target system

Figure 34. Secure Connector installer, user data
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In this example, install the three SAP library files:
v sapjco3.jar
v sapjco3.dll
v sapidoc3.jar
To get the SAP library files, contact your SAP system administrator who can download the files
from the SAP site.
To install the SAP library files into the secure connector, complete the following steps:
1) Under Connector, select SAP. The message The selected connector is SAP is displayed
2) Under Files to Add, click Add, and then browse to and add the three files one by one.
3) Click Update, to add the files to the connector.

The SAP libraries have been installed into the secure connector.

Figure 35. Secure Connector installer, Install Vendor Supplied Libraries page
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l. On the Installation Finished page, click Done.

Results

The App Connect Secure Connector has been installed onto your Windows computer, and you have
added the SAP library files that the connector needs to connect to SAP.

What to do next

Verify that the App Connect Secure Connector can be started.
1. Either select the Start menu option IBM > App Connect Secure Connector xxxx > Start Secure

Connector or run the runclient_osgi file, in this example:
C:\IBM\Secure_Connector_1.7.5.2.0\runclient_osgi.bat

Note: Start the connector with administrator access (Run as Administrator).
2. In the console opened, you should see the message that the connector started successfully:

2017-03-17 15:33:46 INFO Finished loading connector modules
2017-03-17 15:33:46 INFO Secure connector name: SC4SAPConnectivity, Tenant ID: 8
949B362740D64F53EB68378F5D34557, Environment ID: AA4BDC1B88BDAEB0420037DE76A24CE
3
2017-03-17 15:33:47 INFO Secure Connector started successfully

3. In the web management console, check the status of the connector:

Figure 36. Secure Connector installer, SAP libraries installed successfully
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Note: Before you start an orchestration/project that is to use a secure connector, ensure that the secure
connector is created, installed, configured, and is in running state. One secure connector can be used by
more than one endpoint/orchestration.

Checking and updating installed SAP library files
About this task

Sometimes, when trying to connect to SAP you might get an Unable to Connect error. In such cases, you
can usually restore connectivity to SAP by checking and, where needed, updating the installed SAP
library files.

Procedure
v Check and, where needed, update the installed SAP library files

– Unable to connect to Secure Connector SC4SAPConnectivity while trying to do activate. Error
is: Connection refused. Attempt 1 of 5. Will try again in 3 second(s)

(When trying to connect to SAP through the App Connect Secure Gateway, usually when running
an integration project in the web management console.)
Stop, and then reconfigure the Secure Connector to update the three SAP libraries files used when
installing the App Connect Secure Connector; for example:
1. Select Start > All Programs > IBM > App Connect Secure Connector x.x.x.x > Secure Connector

Configuration

2. Click Next several times until the Install Vendor Supplied Libraries page
3. Add the three SAP library files, and then click Update

4. Clicke Next and then click Done.
Restart the Secure Connector to use the updated SAP library files.

– Unable to connect to Secure Connector SC4SAPConnectivity while trying to do activate. Error
is: java.lang.ClassNotFoundException: com.sap.conn.jco.JCo. Attempt 1 of 5. Will try again
in 3 second(s)

(When trying to connect to SAP through the App Connect Secure Gateway, usually when running
an integration project in the web management console.)
Add the SAP library file, sapjco3.dll to the Java bin directory. You can get this file from the
SecureConnector-Production-libraries package downloaded from the web management console.

– Unable to Connect: Required SAP JCO native library is not found. Install version 3.x SAP
JCO native library(.dll or .so based on platform). Detail: Could not initialize class
com.sap.conn.jco.JCo

(Usually when trying to connect to SAP from the Studio.)

Figure 37. Web management console, Secure Connector status RUNNING
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There are several things to try. After trying one solution, reload the project into the Studio and then
try to connect to SAP again.
- If the Secure Connector was not running, start it.
- Reconfigure the Secure Connector to update the SAP library files. (See above.)
- Add the SAP library file, sapjco3.dll to the Java bin directory. (See above.)

– Unable to Connect: Required SAP JCO jars are not found. Install version 3.x SAP JCO jars.

(Usually when trying to connect to SAP from the Studio.)
Check if the following two SAP files are present in the Studio install path and that the files are each
larger than 1 MB; for example:
C:\Users\IBM_ADMIN\AppData\Roaming\castiron\castiron.ibmcloud.com\install
com.approuter.module.jcaconnectors.sap.tp.native-1.0.0.jar 3,772 KB
com.approuter.module.jcaconnectors.sap.tp-1.0.0.jar 1,541 KB

Sometimes a copy of the com.approuter.module.jcaconnectors.sap.tp-1.0.0.jar file smaller than
1 MB is downloaded with the Studio and needs to be replaced. You can get this file from the
SecureConnector-Production-libraries package downloaded from the web management console.

v Download the SecureConnector-Production-libraries package from the web management console
You can download the SecureConnector-Production-libraries package, to get copies of the following
SAP library files:
com.approuter.module.database.tp-1.0.0.jar
com.approuter.module.jcaconnectors.sap.tp-1.0.0.jar
native\libsapjco3.so
native\sapjco3.dll

To download the SecureConnector-Production-libraries package, in the web console select Production >
System > ... > Download libraries.
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Appendix B. Resetting and retrieving the security token for
Salesforce.com accounts

To retrieve the security token of a Salesforce.com account, you have to reset the token.

About this task

The security token of a Salesforce.com account is needed because IBM App Connect Professional connects
through the Salesforce.com API to the Salesforce.com account.

Procedure
1. Log in to Salesforce.com; for example: https://login.salesforce.com/

If you log in to your Salesforce.com account from a web browser or app that Salesforce does not
recognize, Salesforce asks you to verify your identity before you can continue.

2. Click your name at the top right of the screen, and then select My Settings

3. Expand the Personal menu on the left, and then select Reset My Security Token.
4. Click the button Reset Security Token.

Salesforce sends an email to your email address. Access that email and make a note of the security
token. You need the token to set up the connection from App Connect Professional to your
Salesforce.com account.

Tip: Every time you change your Salesforce password, the security token is also changed. When you
copy and paste the token into the endpoint configuration, you must trim out any leading or trailing
spaces, because they might cause authentication errors.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing 2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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IBM Corporation
Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N
Rochester, MN 55901
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Programming interface information
Programming interface information, if provided, is intended to help you create application software for
use with this program.

However, this information may also contain diagnosis, modification, and tuning information. Diagnosis,
modification and tuning information is provided to help you debug your application software.

Important: Do not use this diagnosis, modification, and tuning information as a programming interface
because it is subject to change.
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Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at Copyright and trademark information
(www.ibm.com/legal/copytrade.shtml).
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Sending your comments to IBM

If you especially like or dislike anything about this book, please use one of the methods listed below to
send your comments to IBM.

Feel free to comment on what you regard as specific errors or omissions, and on the accuracy,
organization, subject matter, or completeness of this book.

Please limit your comments to the information in this book and the way in which the information is
presented.

To make comments about the functions of IBM App Connect, you can ask questions in the IBM App
Connect forum on dWAnswers. Alternatively, talk to your IBM representative or to your IBM
authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your
comments in any way it believes appropriate, without incurring any obligation to you.

You can send your comments to IBM in any of the following ways:
v By mail, to this address:

Hybrid Integration Docs (MP095)
IBM United Kingdom Laboratories
Hursley Park
WINCHESTER,
Hampshire
SO21 2JN
United Kingdom

v By email: HIPDocs@uk.ibm.com

Whichever method you use, ensure that you include details that help identify what you are commenting
on:
v The publication title
v The topic to which your comment applies
v Some contact details, like your name and email, if you want a response.
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